Telemetry Data Reduction Workstation

by

Henry Weidman

TRW Systems and Information Technology Group
One Federal Systems Park Drive
Fairfax VA 22033-4411
703-968-1000
73240.1653@compuserve.com

Abstract

STEP mission 4 needed a better system to allow engineers and mission operations people to view archived spacecraft telemetry data. TRW Spacecraft Operations East in Chantilly, Virginia responded with a PC-based system in a few weeks. Software refinements to the system continued for about two months.

This paper outlines the design and implementation of that small satellite telemetry data reduction system which was designed for integration, test and on-orbit operations for the STEP Mission 4 spacecraft. The notable feature of this system is that it is composed of mostly COTS hardware and software which kept the system development cost low and resulted in a short development time frame.

The system provides a method to convert raw binary telemetry data into ASCII records of engineering data which can be imported into Excel, Matlab or similar tools. The data can then be plotted by the user.

Introduction

The need for a tool or system to convert raw binary telemetry data into a format which could be imported into a spreadsheet or other numerical analysis and plotting tool was the driver for the development of a telemetry data reduction workstation. The workstation provides the capability to reduce, archive, and manage raw telemetry data and associated data files such as the telemetry database.

The advantages of using a tool to analyze archived telemetry data are numerous. Data may be plotted over long periods of time (24 hours for example) which is impractical to do in real time. Data which exceeds limits may be plotted or specific events may be found by searching through hours of archived telemetry data.
A Perl program is used to perform the conversion from binary frame data to ASCII records for the user selected parameters. The resulting text file is then processed by an awk program which converts analog counts to decimal integers and stores time data in a string format. The final awk program converts the raw analog counts to engineering units. This is where the power of the awk 4GL may be utilized by the user to perform custom processing by modifying the automatically generated `cnvt2eng.awk` source code. The code may be modified to only print parameter values which exceed or are within a set of limits or new parameters may be derived by applying an algorithm to existing parameters. A sample awk program is shown in Figure 1.

```
Figure 1 - Sample awk program

collect_time = $1
frame = $2
batt1tmp = $3
batt1tmp_eng = (0.3176*batt1tmp) - 16.821

if (batt1tmp_eng > 35)
    printf("%s %s %s \n",
        collect_time, frame, batt1tmp_eng)
```

**Major Software Processes**

The software dataflow diagram (figure 2) shows the data reduction process. The `cnvt2eng.awk` source code is automatically generated based on the list of parameters which the user selects to decommutate. After an initial decommutation pass, the user may modify the generated awk code to perform special processing if desired.
Figure 2 - SOFTWARE DATA FLOW DIAGRAM

1. **.BIN**
   - **BINARY DATA**
   - **extract.pl**
     - Convert binary raw telemetry data to ASCII records with selected telemetry parameters
   - **.TXT**
     - **ASCII DATA RECORDS**
   - **pre_proc.awk**
     - Convert hex to time, integer, or floating point as necessary
   - **.PRE**
     - **.ENG**
       - **ENGINEERING DATA**
     - **excel or matlab**
       - - Apply formulas
         - - Plot data
         - - Scaling

TIME, INTEGER, AND FLOATING POINT DATA RECORDS

Henry Weidman 12th AIAA/USU Conference on Small Satellites
Hardware

The platform for the data reduction workstation is a Pentium PC running Windows NT. The PC was chosen because of its low cost and availability. Windows NT was chosen because a large percentage of currently available PC software requires Windows NT and TRW is gradually upgrading from Windows 3.x to Windows NT and from 486 to Pentium processors. Therefore, the natural choice for hardware and software was simply dictated by the equipment and operating system being used by TRW. The hardware block diagram is shown in figure 3.
Software Tools

Figure 4 lists some of the tools which were used in the implementation of the telemetry data reduction workstation software. The network tools were used to copy telemetry data and log files from remote hosts.

Figure 4. Software Tools

<table>
<thead>
<tr>
<th>MKS Toolkit</th>
<th>Windows NT</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Awk (4GL)</td>
<td>• ftp</td>
</tr>
<tr>
<td>• dlg (create dialog boxes)</td>
<td>• hostname</td>
</tr>
<tr>
<td>• filebox (file selection dialog)</td>
<td>• Command window</td>
</tr>
<tr>
<td>• Korn shell</td>
<td>• ping</td>
</tr>
<tr>
<td>• msgbox (message GUI)</td>
<td>• telnet</td>
</tr>
<tr>
<td>• Perl (4GL)</td>
<td>• Visual C++</td>
</tr>
</tbody>
</table>

The workstation software includes a suite of UNIX tools provided by the MKS Toolkit which is a product of Mortice Kern Systems Inc. The toolkit allows users to quickly and easily create GUI applications using the korn shell and the two 4GLs provided with the tool kit (awk and Perl.) Both awk and Perl have built in record processing features which make them ideal for processing spreadsheet data. The first step is to convert the raw binary data to a set of ASCII hex data. A small Perl program accomplishes this task.

Perl, which stands for Practical Extraction and Report Language, was initially used on UNIX systems, but is now available for use on other platforms. It is both a C and shell-like language. It is capable of processing binary data as well as text data. Today Perl is in wide use for a diverse range of applications.

Once the data is in ASCII format, awk programs are used to process the spreadsheet data.

The use of awk for the final conversion to engineering units allows the user to modify the automatically generated awk program to perform custom processing if desired. Since awk is an interpreter, no compilation is required. The awk program may be executed using the previously decommutated data to produce custom engineering data. Only the final step in the decommutation process needs to be run after the awk program is customized by the user. The other advantage of awk is that it is a powerful 4GL and requires very little source code to perform custom engineering unit conversions. Figure 5 is part of a sample awk program which finds the average, delta (the difference between the minimum and maximum battery temperatures,) minimum and maximum of a number of spacecraft battery temperatures. In the sample program the symbols $1 .. $n represent the field positions of the given item within a data record. The functions delta, average, min and max are part of a library of user created awk functions which are not shown here. Awk has several built-in functions which may be used for engineering unit conversions including atan, sin, cos, exp, log, sqrt and remainder.

Figure 5 - Sample awk program

```
collect_time = $1
frame = $2
batt1tmp = $3
batt1tmp_eng = (0.3176*batt1tmp) - 16.821
batt2tmp = $4
batt2tmp_eng =(0.3176*batt2tmp) -16.821
batt3tmp = $5
batt3tmp_eng =(0.3176*batt3tmp) -16.821
batt[1] = batt1tmp_eng
batt[2] = batt2tmp_eng
batt[3] = batt3tmp_eng
d = delta (batt, 3)
a = average(batt, 3)
min_batt = min(batt, 3)
max_batt = max(batt, 3)
if (max_batt > 35)
  printf("%s %s %s %s %s %s \
",
collect_time, frame,
  min_batt, max_batt, d, a)
```
GUI Interface

The MKS Toolkit has several canned GUI interfaces which can be managed via shell programs. The one which was chosen for the telemetry data reduction workstation is shown in figure 6. The shell program simply calls functions to change the text labels on the GUI window and then responds to window events. The event loop contains user written code to handle each user selection.

Figure 6 - MKS GUI Interface

GSE Telemetry Data Reduction m4

- Extract Analog Data
- Extract Bit Mapped Data
- Create hex frame data file
- Create Power ON/OFF Event Report

Other Programs | Program Descriptions
--- | ---
FileTransfer | transfer files from GSE
copy_raw | copy raw data file to removable drive
Connect | telnet to GSE, ping host
ftp_help | find host names and addresses
experiment_data_1 | decom experiment 1 data
fmt_db | view/search the telemetry database
fmt_cmd_db | view/search the command database
filter | filter text from command logs
search | search for text in command logs

CmdLogs | ViewDb | Edit/View

Henry Weidman
12th AIAA/USU Conference on Small Satellites
Visual C++ GUI Interface

The GUI was replaced with a custom C++ GUI to make the data reduction software interface similar in appearance to other Windows applications. The new GUI is shown in figure 7.

The custom GUI supported the addition of some helpful features including the parameter list editor which is accessed via the Edit menu bar selection. The parameter list editor reads in a previously created parameter list or creates a new list. The telemetry database mnemonics and descriptions are displayed in a window next to the parameter list and the user is allowed to search the telemetry database, select items from the telemetry database, and add the selected items to the parameter list. Items may also be deleted from the parameter list. Once the parameter list is created and saved, and the other decom information is selected by the user, the Start Decom button is pressed to create the engineering data records. These records may be imported into Excel or Matlab and plotted or manipulated as desired by the user.

Tools Menu

The Tools menu contains menu items which allow the user to customize the automatically generated awk program. For example, if the user wanted to search through the telemetry data to find parameters which exceeded a predetermined limit, the tools allow the user to edit and test the customized awk program.

Other Tools menu selections allow the user to create custom command and telemetry database reports, connect to a remote host and access network management tools.

The View menu selection allows the user to view the last set of data which was decommutated, and view the telemetry database report or the command database report.

The Visual C++ program only provides the GUI. Processing is done via system calls to one of the appropriate awk, Perl or Korn shell scripts. This allows the end user to easily modify the processing scripts without needing to recompile any source code.

Tool Usage

The user selects several files from the file menu including the raw data file, the parameter list file, and the telemetry database file. The file menu also includes an option to remotely access a file from the ground support equipment, ground station or other ftp source which contains telemetry data file archives. Once the file is transferred to the local workstation, it may be used as a raw data file for the telemetry data reduction process.

The user then selects which telemetry type to extract from the raw data file by making a selection from the Time Type menu. The output file format is selected from the Chart Type menu and finally the frame numbers are selected from the Frames menu.

Henry Weidman
Telemetry Data Reduction - GSE - TRW

Parameter List:
- BATT1TMP
- BATT2TMP
- BATT3TMP
- BATT4TMP
- BATT5TMP

Frames Selected:
- Frame Interval: 60
- Start Frame: 300
- End Frame: 10000

Decom Setup Information:
- Default Directory: C:\mks\reduction
- Raw Data File: 09251319.it
- Parameter File: Test.prm
- Telemetry Type: SOH
- Chart Type: SPREADSHEET
- Telemetry Database: 4soh.303.csv

Henry Weidman
12th AIAA/USU Conference on Small Satellites
Data Analysis Tools

The data reduction software creates a delimited ASCII file which can be imported into tools like Excel or Matlab. Once the data is imported into a data analysis tool, the user can analyze, plot or apply algorithms to the data. In addition to the use of external data analysis tools, awk or Perl programs can be created to analyze data or perform calculations on the data before importing the data into the plotting tool.

Archives Capability

In addition to the data reduction capability provided by the workstation, the removable 1.2 GB optical drive provides a medium for archival of raw telemetry data, log files, command and telemetry databases and even source code so that the relevant decommutation algorithms and database information may be shrink wrapped with the raw data files. In fact, all relevant I&T data files may be stored along with the raw data. This also provides a backup for the archive data which is stored on the remote GSE.

Conclusion

The use of COTS hardware and software allowed TRW to design and implement their new data reduction system in a short period of time with minimal resources. The system was implemented in approximately three months with one full time software engineer. Only a few hundred lines of custom code were required for the telemetry processing software. The Visual C++ code was also limited to a few hundred lines of custom code.

The system was up and running as soon as the COTS software was installed. Refinements to the GUI required most of the software development time following the initial system installation. The system may be used without a GUI by knowledgeable users who do not mind writing their own shell and awk scripts to perform the engineering unit conversions.

The reason for the GUI is to simplify this process for the average user.

The system performance exceeded that of the COTS playback software which was evaluated and the workstation performance could be further enhanced by moving to a faster CPU and adding more RAM.

The use of 4GLs adds flexibility to the system and allows users to easily modify the engineering unit conversion program to perform special processing.

The raw telemetry data format may be changed by modification of the Perl program which reads the binary telemetry stream.

Changes to the telemetry database are performed by simply loading a new version of the database file.

In summary, the system does not seem to have any practical limitations.

Biography

The author has been a Member of the Technical Staff at TRW Systems and Information Technology Group for the past eleven years. During that time period he has worked in a software development role on various projects including communications systems, database systems, automated fingerprint identification systems and spacecraft ground support systems. Prior to his employment with TRW, the author was involved in the development of data acquisition systems, telephone switching systems, computer networks, and avionics systems. He graduated from the University of Maryland in 1983 with a Bachelor of Science degree in Information Systems Management.

Henry Weidman

12th AIAA/USU Conference on Small Satellites
References
